
Data
Journalism

18 LESSONS 100 MIN TOTAL

This course will help you unlock the powerful world of 
data journalism to tell deep, insightful stories. You’ll 
learn to find, analyze, interpret and visualize data in 
compelling new ways.

Tools Used:
Google Permissions, Google Public Data Explorer, 
Google Surveys, Google Crisis Map, Global Forest 
Watch, Election Databot, Tilegrams, Google Data GIF 
Maker, Flourish, Google Trends, Google Fusion Tables, 
Google Sheets, Google Data Studio



Permissions: Source 
Google data
Learn proper usage and citations for Google products.

LESSON 01



Lesson overview
How to use the Google brand in your 
content.

The Google Permissions website is your one-stop-shop to 
learn how to properly use and cite our products in your stories. 
It highlights common use cases, basic trademark guidelines 
and gives instructions on using our logos, images, maps and 
graphics across all media.

Citing maps sources.

Giving Credit where it's due.
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STEP 2 OF 2

Citing maps sources.

From satellite images to maps, journalists around the world use our tools to help 
tell their stories. And we’re glad. We simply ask that you follow some usage rules 
to ensure they’re used fairly and properly.

Let’s say you’re publishing a web infographic using an 
image from Google Earth. Go to google.com/permissions 
and click Products.

Scroll down until you see Google Maps/Earth and click 
guidelines for non-commercial use. The General 
Guidelines section should answer most FAQs for Google 
map usage. 

STEP 1 OF 2
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Giving credit where it's due.

When you’re ready to publish, make sure you properly cite 
your Google source. Many of our products, such as 
Google Maps and Google Earth, will automatically 
incorporate an attribution for Google and the data 
provider. We’ve also set up an attributions site to answer 
your more detailed questions.

SINGLE STEP
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Congratulations!
You completed “Permissions: Source Google 
data.”

To continue building your digital journalism skills and work toward Google News 
Initiative certification, go to our Training Center website and take another lesson:

6 min estimated time

Public Data Explorer: Access a 
world of data

Use high-quality data sets to create 

compelling visuals.
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Public Data Explorer: 
Access a world of data
Use high-quality data sets to create compelling visuals.

LESSON 02



Lesson overview
Find and visualize high-quality data.

When you’re researching a story or on a tight deadline, finding 
quality datasets can be a roadblock. Google Public Data 
Explorer helps you find, interpret and share data to show how 
our world is changing.

It aggregates datasets from trusted sources and gives you 
simple tools to create sophisticated visualizations. With Google 
Public Data Explorer, you can monitor change over time, 
identify trends, compare metrics and strengthen your story 
using data.

A single source for quality data.

A library organized for fast, easy search.

Tell your story through charts, graphs or maps.
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STEP 2 OF 2

A single source for quality data.

With datasets from the World Bank, IMF, Eurostat and more, Public Data Explorer 
provides global statistics on the environment, economics, labor, health, 
education, poverty and more. You’ll also find more granular data from state and 
local governments, universities and nonprofits. So, whether your search is broad 
like “global CO2 emissions” or narrow like “high school dropout rates in Texas,” 
there’s a wealth of data to support your story.

Public Data Explorer can also help you uncover new data sources. 

To  learn when the data was published and who created it, 
click the blue links.

To go to the site where the dataset is hosted, and look for 
different file formats, click More Info.

STEP 1 OF 2
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STEP 2 OF 2

A library organized for fast, easy search.

The Google Public Data Explorer helps you search datasets and metrics by 
keywords as quickly as you would with Google Search.

A Dataset is a bundle of statistics created by a single data 
provider. For example, "Population of the United States," 
from the US Census Bureau, and "World Development 
Indicators," from the World Bank.

Metrics are statistics that are components of a larger 
dataset. These include topics like “population,” 
“unemployment rate,” and “GDP.” By default, search 
results appear in Metrics mode. You can switch modes by 
clicking Datasets on the left side of the page.

STEP 1 OF 2
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STEP 2 OF 4

Tell your story through charts, graphs or maps.

When it comes to statistics, visual representations can be powerful. In Google 
Public Data Explorer, the visualizations are dynamic, so you can watch them move 
over time, change topics, highlight different entries and alter the scale. You can 
easily publish a visualization with your story.

Select a visualization type (line, bar, map, bubble).

Choose statistics to show, compare and filter.

STEP 1 OF 4
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In a bar, map or bubble chart, click Play to animate it over 
time. 

In a line chart, you’ll adjust the x-axis time range by sliding 
the tabs in the timeline.

STEP 4 OF 4

STEP 3 OF 4
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Congratulations!
You completed “Public Data Explorer: Access a 
world of data.”

To continue building your digital journalism skills and work toward Google News 
Initiative certification, go to our Training Center website and take another lesson:

5 min estimated time

Google Surveys: Gain insights

Gather data from real people by creating your 

own surveys.
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Google Surveys: 
Gain insights
Gather data from real people by creating your own 
surveys.

LESSON 03



Pick your audience.

Write your questions and answers.

Field and pay for your survey.

1
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Track your surveys.

Interpreting survey results for your story.

4

5

Survey your own readers.6

Lesson overview
Conduct your own research by 
creating a survey.

Google Surveys is useful for getting a clearer picture of 
people’s opinions and perspectives to backup your story. You 
can create a survey on any topic and put it in front of people in 
real time.

For example, if you’re researching how drought in the western 
United States affects people’s water usage, you can gather 
data through a geo-targeted survey.

Results are quick and accurate: you’ll begin receiving 
responses from a validated representative sample within 24 
hours. Pricing starts at 10 cents per completed response.
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Pick your audience.

Who do you want to answer your questions? To reach the 
general population, you can run your survey on our 
network of online publishers. Or, you can select more 
specific groups like Android smartphone users or 
audience panels. 

Then, you can target participants based on demographics, 
like age, gender, and location. You can further narrow your 
audience with screening or pre-qualification questions. 

To get started, go to g.co/surveys

SINGLE STEP
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STEP 2 OF 4

Write your questions and answers.

You can choose from a variety of question formats including single answer, 
multiple answer, and rating scale. You may write up to 10 questions, but bear in 
mind that shorter surveys yield faster results.

Choose your format, then click Add question.

Type in a question.

STEP 1 OF 4
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Type in your answer options and click Add question to 
build out your survey.

To preview your survey on desktop or mobile, click the 
brackets.

STEP 4 OF 4

STEP 3 OF 4
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STEP 2 OF 2

Field and pay for your survey.

When you are satisfied with your survey, click Confirm 
and review all of your information, including the number of 
respondents you’d like.

Enter your payment information, select frequency, then 
click Buy Now.

STEP 1 OF 2
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STEP 2 OF 2

Track your surveys.

The Google Surveys dashboard keeps all of your 
information in one place. You can monitor surveys in 
progress and review past surveys. 

To return to your dashboard, go to g.co/surveys, sign in to 
your account and select Surveys.

STEP 1 OF 2
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STEP 2 OF 2

Interpreting survey results for your story.

Full survey completion typically takes a few days to a week.
To learn more about Google Surveys, click here.

As results roll in, Google automatically aggregates and 
analyzes responses, sending you data through a simple 
online interface.

It includes interactive histograms, clickable demographic 
segmentation and comparisons, and significant insights ― 
all easily shareable with your colleagues. 

STEP 1 OF 2
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STEP 2 OF 2

Survey your own readers.

Want to find out what your readers think? Use Google Surveys to ask them 
questions on your own site. It’s free of charge and offers the same functionality as 
the paid solution. 

You have sign up to this program, get approved by Google and embed some code 
onto your site.

To begin this process, first sign up for Google Opinion 
Rewards here.

Then, go back into Google Surveys and follow the same 
process you would for a paid survey, except under 
Audience, choose Your website. You will also go through 
the same “buying” process but you will not be charged 
a fee.

STEP 1 OF 2
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Congratulations!
You completed “Google Surveys: Gain insights.”

To continue building your digital journalism skills and work toward Google News 
Initiative certification, go to our Training Center website and take another lesson:

10 min estimated time

Google Crisis Map: Diagramming 
a disaster and its response

See the latest crisis-related data and 

customize it for your story.
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Google Crisis Map: 
Diagramming a 
disaster and its 
response
See the latest crisis-related data and customize it for 
your story.

LESSON 04



Explore archived Crisis Maps.

Customizing the Crisis Map.

Customization for advanced users.

1

2

3

Sharing the Crisis Map.

Receive alerts for new Crisis Maps.

4

5

Lesson overview
About the Crisis Map.

When a disaster strikes, Google Crisis Response helps ensure 
that accurate information is available to those affected.

The Google Crisis Response team works directly with 
authoritative emergency organizations such as the Red Cross, 
NOAA and many others to create and update the Google Crisis 
Map, which features helpful information regarding disasters all 
over the world.

The Crisis Map can help journalists visualize and share 
crisis-related data, and includes relevant information such as 
shelter locations, weather, evacuation zones, post-event 
satellite imagery and more.

25newsinitiative.withgoogle.com
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Explore archived Crisis Maps.

To get to know the tool, go to 
https://google.org/crisismap. Then start by exploring a 
growing collection of archived Crisis Maps. Just click the 
dropdown arrow next to the title of the current map.

SINGLE STEP
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STEP 2 OF 3

Customizing the Crisis Map.

By default the Crisis Map displays multiple layers of information. But it’s easy to 
customize the map and highlight only specific information.

Let’s say you were writing about Typhoon Yolanda, which 
hit Southeast Asia in 2013, and wanted to feature a map of 
just Evacuation Centers in your story. You would just open 
the Layers panel and uncheck boxes to remove 
information you don’t want to appear. Whatever layers you 
check will be displayed on the map when you copy and 
share its URL or embed code, which will be explained in an 
upcoming screen.

You can also choose a specific area of the map to display, 
and select satellite imagery based on the date it was 
collected. On the Layers tab click Satellite Imagery, then 
the date.

STEP 1 OF 3
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To better feature this imagery, click Zoom to area and 
position your map. Use the Zoom tool to get closer to the 
details in the satellite imagery.  

The final layer and position you choose will be saved and 
appear in the map when you share it.

STEP 3 OF 3
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Customization for advanced users.

Whenever possible, Crisis Response provides a download 
link with individual information layers on the Crisis Map so 
that it can be downloaded as KML (Keyhole Markup 
Language) data.

A reporter can, for example, use that KML data in Google 
Earth Pro to help create a customized video tour of the 
crisis area. See our Google Earth lesson for information 
about creating, customizing and exporting video tours for 
news reports.

SINGLE STEP
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STEP 2 OF 2

Sharing the Crisis Map.

The Google Crisis Response team makes it easy for trusted news sources to 
share and embed Crisis Maps as part of their coverage.

Once you’ve customized the Crisis Map with the 
information and area you want to feature, click Share at 
the top of the map. 

In the pop-up window you can share the map on social 
media or copy the map’s URL.

You can also embed the map on your website using the 
iframe provided. In that code, you can customize the 
height and width of the map embed.

STEP 1 OF 2
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STEP 2 OF 2

Receive alerts for new Crisis Maps.

To find out when the Google Response Team launches a new Crisis Map, sign up 
for our Google Geo Media Updates group. 

To sign up, go to 
https://groups.google.com/forum/#!forum/geomedia-upd
ates and click Apply to join group.

Edit your display information, email preferences, 
and provide your company info. Then click Apply to 
join group.

STEP 1 OF 2
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Congratulations!
You completed “Google Crisis Map: 
Diagramming a disaster and its response.”

To continue building your digital journalism skills and work toward Google News 
Initiative certification, go to our Training Center website and take another lesson:

5 min estimated time

Data Source: Global Forest 
Watch

Deforestation data and monitoring tools.
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Data Source: Global 
Forest Watch
Deforestation data and monitoring tools.

LESSON 05



Lesson overview
What is Global Forest Watch?

Global Forest Watch (GFW) is a remarkable collaboration of the 
World Resources Institute, Google, the Jane Goodall Institute 
and other partners that provides data and tools to help 
journalists, governments and researchers understand harmful 
forest loss and its effect on climate change. 

In the past, people have struggled to understand when and 
where forests are cleared, why it happens, and who is 
responsible. Using satellite data and cloud computing, GFW 
monitors the world’s forests in near real time—delivering data 
about deforestation, fires, climate and commodities that would 
have formerly taken years to gather and process.

34newsinitiative.withgoogle.com

Reporting on climate change.

Interactive map of forest change.

Customize your interactive map.
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Country profiles.

Monitoring fires on GFW.

4

5

Analyze commodity supply chains.

Learn more about GFW.
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Reporting on climate change.

The GFW platform will help you report on climate change 
by providing timely, in-depth information on carbon 
emissions from tropical deforestation. You can explore 
landscapes and analyze carbon data on our interactive 
map, as well as customize reports to show only the data 
you want to see and share it with your story. 

Several tools also help you monitor change over time and 
compare countries, jurisdictions and areas of interest. You 
can even monitor deforestation in conjunction with carbon 
emissions, and look at data on canopy density, carbon 
stores in trees and carbon stores in soil.

SINGLE STEP
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STEP 2 OF 4

Interactive map of forest change.

The central tool of GFW is an interactive map depicting the world’s forest change 
(tree cover and loss) powered by data sets that stretch from 2000 to 2018.

To explore the interactive map, first go to 
globalforestwatch.org, then Map.

Use the map to look at forests around the world.

STEP 1 OF 4
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To focus on subsets of time, use the slider at the bottom 
of the map.

Turn specialty layers on or off to show factors such as 
conservation areas, land use, and intact forest landscapes.

STEP 4 OF 4

STEP 3 OF 4
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STEP 2 OF 2

Customize your map view by clicking Country Data and 
selecting a country or region or drawing your own area to 
analyze. 

Choose from a variety of base map options such as 
satellite, terrain or road maps.

STEP 1 OF 2
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Customize your interactive map.

The interactive map also allows you to get more granular views of impacts in 
specific regions you may be covering and to modify the look of the map per 
your needs.



STEP 2 OF 5

Country profiles.

If you know what country you want to research, you can go straight to its profile. 
GFW carries data on 204 countries.

Rollover the navigation bar to reveal the top nav. Then click 
Countries. 

Choose from the 204 countries 

STEP 1 OF 5
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Using Indonesia as an example, you can see a remarkable 
amount of data.

Click through the tabs to reveal statistics on land cover, 
forest loss and management, economic impact and 
employment related to forests, governmental 
management, reforestation, CO2 emissions, carbon 
stocks and international agreements. 

You can also see a country’s forest profile in context with 
other countries by choosing Rankings. This shows the 
countries with greatest tree cover loss at the top: Russia, 
Brazil and Canada.

STEP 4 OF 5

STEP 5 OF 5

STEP 3 OF 5
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STEP 2 OF 5

Monitoring fires on GFW.

GFW Fires is a tool to monitor emerging fires, identify potential causes, and 
analyze impacts of fires on forests and people.

From any page, you can click More to access additional 
GFW apps.

Select Global Forest Watch Fires.

STEP 1 OF 5
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Click View Map. 

Here you can see fires around the world, look at air quality 
and haze, and quickly access a fire report for any country 
in the past seven days.

You can also sign up to receive fire alerts via SMS or email 
for any region you need. Just click Start Drawing and 
outline the desired area.  Then click the fire alerts email 
or SMS messages link.

STEP 4 OF 5

STEP 5 OF 5

STEP 3 OF 5
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STEP 2 OF 6

Analyze commodity supply chains.

The GFW Commodities tool illuminates deforestation related to commodity 
supply chains for palm oil, soy, beef, wood pulp, and other products. For example, 
you can monitor activity in Indonesia near palm oil mills to see if there is 
corresponding forest loss in the area. This tool may be extremely useful for 
journalists covering the intersection of business interests and environmental 
preservation.

From any page, you can click More to access additional 
GFW apps.

Click Global Forest Watch Commodities.

STEP 1 OF 6
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Click the Click Here! button.

Select Explore Global Data on the GFW Commodities 
Map.

Under Forest Use, turn on RSPO Palm Oils Mills and Palm 
Oil Mills. 

STEP 4 OF 6

STEP 5 OF 6

STEP 3 OF 6
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Under Forest Change, turn on Loss to see the Tree Cover 
Change in that area. You can adjust the opacity of the 
layer with the slider so you can continue seeing the details 
beneath.

STEP 6 OF 6
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Learn more about GFW.

The GFW platform is an incredibly rich source of 
information for journalists. While this lesson provides an 
overview of its tools, there are many video tutorials you 
can watch to dive deeper. 

For videos on analyzing forest change, visualizing country 
data, comparing countries and much more, watch Global 
Forest Watch Tutorial videos.

SINGLE STEP
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Congratulations!
You completed “Data Source: Global Forest 
Watch.”

To continue building your digital journalism skills and work toward Google News 
Initiative certification, go to our Training Center website and take another lesson:

5 min estimated time

Data Source: Election DataBot

A robust tool to help journalists cover U.S. 

elections
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Data Source: 
Election DataBot
A robust tool to help journalists cover U.S. elections

LESSON 06



Stay up to date with "The Firehose."

Analyzing campaign finance data.

Knowing what organizations are spending money in a race.

1

2

3

Seeing shifts in campaign donations.

Tracking data from polls.

4

5

Learn from Google Trends search data.

Setting alerts for races you care about.

6

7

Lesson overview
An election data hub created by 
ProPublica and Google News 
Initiative.

There are countless stories to tell about U.S. political 
campaigns—and data can help you tell them. In collaboration 
with the public interest journalism nonprofit ProPublica, we 
created Election Databot to help you find the most interesting 
data in near real time about presidential and congressional 
candidates in the U.S.
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Stay up to date with "The Firehose."

The centerpiece of the Databot is the Firehose, a stream 
of information related to U.S. elections that is updated 
every 15 minutes and pulled from a variety of sources. 
Here, you’ll find the most interesting data including 
campaign finance filings, Google search trends, new polls, 
forecasts from FiveThirtyEight, Cook Political Report race 
ratings and vote activity from sitting members of 
Congress. It will tell you when a super PAC spends money 
in a race you care about, when an incumbent member of 
Congress is the only person to vote against a piece of 
legislation, when key polls change, and much more.

The Databot uses information from multiple high-quality, 
nonpartisan  sources, including government and 
commercial websites. To learn about our methodology, 
read this article on our sources.

SINGLE STEP
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STEP 2 OF 3

Analyzing campaign finance data.

Our Firehose draws from a companion tool, the Federal Election Commission 
(FEC) Itemizer, to provide detailed data about campaign finance filings. Learning 
to differentiate and interpret these filings can help you find stories.

Comparing candidates and races. Election Databot ranks 
House and Senate candidates in terms of money raised 
and spent, both within their states and nationally.

Knowing what organizations are spending money in a 
race. You can track a race or candidate, so you get alerts 
when super PACs, and/or other committees spend money 
to influence an election. You also can track individual 
committees, seeing where and when they spend money in 
races. 

STEP 1 OF 3
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Seeing late shifts in campaign donations. In the final weeks 
before a state or general election, House and Senate 
candidates are required to file reports to the FEC within 48 
hours of receiving a contribution of $1,000 or more. These 
“48-Hour” reports can show that a candidate’s campaign 
is seeking donations from congressional colleagues, family 
members and out-of-state donors and can be an 
indication that a campaign believes it has a more difficult 
race than expected. For example, the string of 48-Hour 
reports by then incumbent Kansas Republican Tim 
Huelskamp included contributions from his mother. Soon 
after, Huelskamp lost his primary.

STEP 3 OF 3
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STEP 2 OF 4

Knowing what organizations are spending 
money in a race.

You can track a race or candidate, so you get alerts when super PACs, and/or 
other committees spend money to influence an election. You also can track 
individual committees, seeing where and when they spend money in races.

Say you’re writing a story on fundraising for Kansas Republican Tim Huelskamp.

On the homepage, type the candidate’s name into the 
search field. 

You’ll land on an overview page that features the latest 
stories in The Firehose as well as links to detailed spending 
info in the right sidebar.

STEP 1 OF 4
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Click See all fundraising in the right sidebar.

Here you’ll find how much he’s received in contributions 
and how much has been spent campaigning.

STEP 4 OF 4

STEP 3 OF 4
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Seeing shifts in campaign donations.

In the final weeks before a state or general election, 
House and Senate candidates are required to file reports 
to the FEC within 48 hours of receiving a contribution of 
$1,000 or more. These “48-Hour” reports can show that a 
candidate’s campaign is seeking donations from 
congressional colleagues, family members and 
out-of-state donors and can be an indication that a 
campaign believes it has a more difficult race 
than expected. 

For example, the string of 48-Hour reports by then 
incumbent Kansas Republican Tim Huelskamp included 
contributions from his mother. Soon after, Huelskamp lost 
his primary.

SINGLE STEP
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STEP 2 OF 3

Tracking data from polls.

Polling and political analysis are not perfect, but they can both be useful tools for tracking an election. 
The Databot tracks both, providing alerts on new polls in the presidential and congressional races, 
election forecasts based on poll analysis, and race ratings.

We use Huffington Post Pollster API for polling data,  FiveThirtyEight’s Election Forecast to provide win 
probabilities and the Cook Political Report for independent, nonpartisan  analysis that rates each race 
on a spectrum of “Solid” to “Toss-Up.”  When a poll or race rating changes, you can use that and other 
Election Databot information such as campaign finance filings, to try to understand why.

Say you want to see which way New Jersey’s senate race is polling.

Select New Jersey in the search box. Then click All Races.

Choose the Senate Race.  

STEP 1 OF 3
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You’ll see Cook Political Report rates this as a “Likely 
Democratic” win.

STEP 3 OF 3
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Learn from Google Trends search data.

What internet users search for can be a useful indicator. 
While search interest is not a perfect predictor of electoral 
performance, it has caught the attention of researchers. In 
the 2016 Republican presidential primary, Google search 
interest tracked closely with results in a number of states.

The Databot uses data from Google Trends to show when 
search interest — represented by a sample of Google 
searches — increases for a particular candidate within his 
or her home state. Many candidates see relatively little 
search interest, so we try not to surface small increases, 
instead looking for rising interest over a number of hours.

SINGLE STEP
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STEP 2 OF 3

Setting alerts for races you care about.

Following a specific race? You can set alerts to notify you when new filing or data 
points happen. 

Navigate to the race you want to follow and sign into your 
Google account.

Click Get alerts for this race to follow.

STEP 1 OF 2
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You can edit and manage alerts by clicking Manage alerts 
on the top right. This will enable you to customize the 
elections you follow and frequency of emails you receive.

STEP 3 OF 3
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More ways to learn about 
Election DataBot.

For additional tutorials on Databot, watch our series of 
YouTube videos.

Read our Medium article by Google News Initiative Data 
Editor Simon Rogers: Election Databot: Harnessing the 
power of the matrix.

SINGLE STEP
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Congratulations!
You completed “Data Source: Election DataBot.”

To continue building your digital journalism skills and work toward Google News 
Initiative certification, go to our Training Center website and take another lesson:

5 min estimated time

Visualizing Data: Introduction to 
Tilegrams

A new way to map data.
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Visualizing Data: 
Introduction to 
Tilegrams
A new way to map data.

LESSON 07



Lesson overview
A free data visualization tool.

Short for “tiled cartogram,” a Tilegram is a map made of tiles 
where regions are proportional to a data set. Tilegrams can 
represent demographic data more accurately than traditional 
geographic maps, but still retain a familiar shape. For example, 
this Tilegram of the United States shows population and better 
illustrates how many people inhabit each region—yet the U.S. 
landform is still recognizable.

Tilegrams is not just for population-related data; you can use it 
to visualize almost any type of proportional comparison in a 
geographic region. Check out the tool, here
https://pitchinteractiveinc.github.io/tilegrams/

Access our existing Tilegrams.

Refining an existing Tilegram.

Adding and removing tiles.

1

2

3

64newsinitiative.withgoogle.com
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STEP 2 OF 2

Access our existing Tilegrams.

Developed by Pitch Interactive, Tilegrams are free for everyone to use. 

You can browse the existing selection of Tilegrams, 
which includes maps of the U.S. from Pitch, NPR and 
FiveThirtyEight, 

There are also maps for Germany, France and a growing 
list of countries. 

STEP 1 OF 2
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STEP 2 OF 4

Refining an existing Tilegram.

Tilegrams use algorithms to compile visuals, so it’s inevitable that they may 
display visual inaccuracies. To tell a complete and accurate story, there are many 
ways you can modify your Tilegram. If you’ve loaded one, there are many ways 
you can modify it.

Click and drag any tile to move it around.

To move multiple tiles, click and drag a rectangular 
marquee around them and then drag them around. 

STEP 1 OF 4
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To move a specific region, double click any tile in it to 
select them all and then drag the whole region.

To adjust the resolution, click the Generate from data 
button and use the slider. 

STEP 4 OF 4

STEP 3 OF 4
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STEP 2 OF 4

Adding and removing tiles.

As you make refinements to your data, the map will change and may reveal some 
inaccuracies. This a normal occurrence in Tilegrams because it is difficult to 
produce both accurate and recognizable results. As you begin to make your own, 
you’ll experience the trade-offs involved.

Click Refine. 

Under State Tiles you’ll see a list of each state with a 
number and a hexagon. The number indicates the 
difference between the number of tiles that region 
currently has on the map and how many it should have, 
based on the dataset. If the number is positive, that region 
has too many tiles on the map. If it’s negative, it doesn’t 
have enough. If there’s a warning sign, then the region 
doesn’t have enough data for even a single tile on the map 
at the chosen resolutions.

STEP 1 OF 4

68newsinitiative.withgoogle.com



To remove a tile from the map, click it and hit “delete” on 
your keyboard.

To add a tile, select Refine, click on a hexagon from the 
left sidebar and drag it onto the map.

STEP 4 OF 4

STEP 3 OF 4
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Exporting existing Tilegrams.

When you are happy with your Tilegram, you can export it. 
For use in design software, choose the file type SVG using 
the buttons at lower left. Developers should select 
TopoJSON to export it into their web applications. 

For more on Tilegram basics, see the tool and read our 
post on Medium.

SINGLE STEP
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Congratulations!
You completed “Visualizing Data: Introduction to 
Tilegrams.”

To continue building your digital journalism skills and work toward Google News 
Initiative certification, go to our Training Center website and take another lesson:

5 min estimated time

Visualizing Data: Advanced 
Tilegrams

Generate your own Tilegram from data.
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Visualizing Data: 
Advanced Tilegrams
Generate your own Tilegram from data.

LESSON 08



Starting with data.

Finding Geo ID codes for different regions.

Formatting your Custom CSV.

1

2

3

Making your Tilegram.

Adjusting and downloading.

4

5

Lesson overview
Generating new Tilegrams.

You can produce a truly custom Tilegram by modifying the data 
in the available base maps or by uploading your own data.  
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STEP 2 OF 3

Starting with data.

Begin by selecting Generate from data. 

Click on the dropdown menu, and you’ll see that you can 
choose from a few data-driven U.S. Tilegram base maps.

STEP 1 OF 3
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You can also choose Custom CSV to upload your own 
data set.

STEP 3 OF 3
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STEP 2 OF 5

Finding Geo ID codes for different regions.

To generate a new Tilegram, you’ll need to know its Geo ID coding; these are the 
inputs that give your Tilegram the right geographic shape. For example, the US 
uses FIPS state codes to identify its 50 states and additional territories. France 
and Germany use ISO-3166-2 codes. 

On the homepage, click FIPS Codes for the States and 
the District of Columbia.

You’ll find the individual state codes in the center column.

STEP 1 OF 5
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Click the Germany Geo ID link above and you’ll arrive at a 
map of German constituencies

Zoom in on the map to reveal the code for each 
constituency

Click the France Geo ID link above and you’ll find the 
region codes under the column labeled GN

STEP 4 OF 5

STEP 5 OF 5

STEP 3 OF 5
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STEP 2 OF 2

Formatting your Custom CSV.

Open a spreadsheet editor. To create your Comma 
Separated Values (CSV) data source, you will use a 
three-column model.  Column 1: The Geo ID tag for the 
area. This tells our software “where.” Column 2: The value 
you want to assign. This tells our software “how many.” For 
example, population, GDP, etc. Column 3: A text label 
describing the territory such as “California” or “New York”. 
This does not affect the shape of the Tilegram in any way.

Export as a CSV.

STEP 1 OF 2
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STEP 2 OF 3

Making your Tilegram.

Once your data source is properly formatted and ready, 
select all and copy.

Paste the values into the window labeled Paste Custom 
CSV below:. 

STEP 1 OF 3
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Your Tilegram should begin automatically generating in the 
window to the right.

STEP 3 OF 3

80newsinitiative.withgoogle.com



STEP 2 OF 2

Adjusting and downloading.

Now, you can follow the same steps you would use for an existing Tilegram. 

For a detailed look at how Tilegram was created, read Pitch Interactive’s blog post.

Drag tiles around. 

Adjust the resolution to find the right balance to keep your 
creation statistically accurate and geographically 
recognizable. 

STEP 1 OF 2
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Congratulations!
You completed “Visualizing Data: Advanced 
Tilegrams.”

To continue building your digital journalism skills and work toward Google News 
Initiative certification, go to our Training Center website and take another lesson:

5 min estimated time

Google Data GIF Maker

Visualize data comparisons in minutes.
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Google Data GIF 
Maker
Visualize data comparisons in minutes.

LESSON 09



Choose two data points.

Customize your design.

To create your GIF, select Preview GIF.

1

2

3

Download your GIF.4

Lesson overview
A simple tool for showing data 
comparisons.

Data visualizations are an essential storytelling tool in 
journalism, and though they are often intricate, they don’t have 
to be complex. In fact, with the growth of mobile devices as a 
primary method of consuming news, data visualizations can be 
simple images formatted for the device they appear on. 

The Google Data Gif Maker helps journalists make visuals that 
show share of interest for two competing topics. It is designed 
for desktop use on Chrome and may not function properly on 
mobile devices or other browsers.  To begin, go to 
datagifmaker.withgoogle.com, where you can make up to five 
different GIFs at a time.
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STEP 2 OF 4

Choose two data points.

Data GIF Maker is ideal for comparing the relative search interest for two 
competing terms using the Google Trends Explore function.

In Google Trends, enter two competing terms, such as 
Monsoon and Typhoon.

Specify the time range and region you want to compare, 
such as Past 30 days and India. 

STEP 1 OF 4
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You’ll see the average relative search interest based on 
your inputs. 

You can also use Data GIF Maker to compare any two data 
points of your choosing such as polling numbers, sales 
figures, movie ratings, etc. simply by entering the two 
numbers.

STEP 4 OF 4

STEP 3 OF 4
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STEP 2 OF 3

Customize your design.

Now that you’ve chosen your data points, go to datagifmaker.withgoogle.com to 
begin creating your GIF.

Add the name of each of your two data points, the 
numbers representing your data, and explanatory text at 
the bottom such as “search interest.” Do not use commas 
within numbers: for example, 1,000,000 would be entered 
as 1000000. However, you can use comma-separated 
values to create a toggle effect in the animation.

Choose whether you want to show terms as numbers or 
percentages by clicking either the + or % icon. For 
percentages, just enter your values and the app 
automatically calculates the % ratio for you.

STEP 1 OF 3
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Next, select colors by clicking on the colored dots. 

STEP 3 OF 3
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STEP 2 OF 3

To create your GIF, select Preview GIF.

To preview single or multiple GIFs, click on Preview GIF. 

The tool will automatically open a new browser window 
and show you up to five GIFs you’ve created.

STEP 1 OF 3
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If you’d like to preview each segment or GIF separately, 
just click Preview GIF with Autoplay All turned off and 
then hit the spacebar to advance through each visual, 
step by step.

STEP 3 OF 3
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STEP 2 OF 3

Download your GIF.

When you’re satisfied with your creation, 
click Create GIF. 

The high-resolution download may take a few minutes, but 
it provides better quality for social sharing. To speed up 
the process, we recommend that you leave your browser 
window open on your desktop while it’s creating the GIFs.

STEP 1 OF 3
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Once it’s 100%, click Download Now.

STEP 3 OF 3
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Congratulations!
You completed “Google Data GIF Maker.”

To continue building your digital journalism skills and work toward Google News 
Initiative certification, go to our Training Center website and take another lesson:

7 min estimated time

Flourish: Data Visualization 
Templates

A simple tool to help newsrooms create 

beautiful graphics.
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Flourish: 
Data Visualization 
Templates
A simple tool to help newsrooms create beautiful 
graphics.

LESSON 10



Lesson overview
Free data visualization templates for 
newsrooms.

With its journalism roots, Flourish is designed to help 
newsrooms increase the quality and quantity of their data 
stories. Built by London data studio Kiln, Flourish offers 
beautifully designed data visualization templates. Google News 
Initiative partners with Flourish to offer the tool for free 
editorial use in newsrooms. You can customize many aspects 
of the templates with no coding experience. Or, your 
developers can use Flourish tools to create and share 
templates with other publications.

95newsinitiative.withgoogle.com

Sign up for a free account.

Get acquainted with Flourish.

Prepare your data set.

1

2

3

Starting your project.

Customize your visualization.

4

5

Preview your project on multiple screens.

Publish your visualization.

6

7
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STEP 2 OF 3

Sign up for a free account.

To begin, click Get started for free.

Sign in with Google or enter your name and email to 
create an account. 

STEP 1 OF 3
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Answer a few simple questions and click Submit. 

STEP 3 OF 3
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STEP 2 OF 2

Get acquainted with Flourish.

There are several different types of templates currently available, with more being 
added all the time. From “horse race” visuals that compare multiple data points 
over time to renderings of the globe that show relational data, you can choose 
the right type of visual to tell your story.

To get started, click Create a visualization.

Find the best template for your story in a growing 
collection.

STEP 1 OF 2
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STEP 2 OF 4

Prepare your data set.

Flourish works with Excel spreadsheets and Comma Separated Value (CSV) files. 
To save time in the long-term, make sure your data set is organized and free of 
errors.

To learn more about a template and whether it’s right for 
the type of data you want to visualize, click Need help 
with this template?

The Template Guide is filled with details about best uses, 
data requirements, and tips.

STEP 1 OF 4
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Once you choose a template, click on Create 
Visualization.

Click Data to see how to format your CSV properly. 

STEP 4 OF 4

STEP 3 OF 4
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STEP 2 OF 5

Starting your project.

Let’s say you’re writing a trend piece analyzing U.S. baby girls’ names over time 
and you want to use  a “horse race” template.

Select Import your data and be sure to name your data 
sheet.

Make sure that Overwrite current sheet is selected, then 
click Import.

STEP 1 OF 5
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Click Next, select the columns. 

Then label the columns you want to visualize. If there is an 
image you want to associate with the data and the 
template you chose allows it, click on the Image column 
field and enter the header letter of  the column that 
contains your image URLs. If there’s no image, leave the 
Image column field blank.

Click Preview to see your data visualized.

STEP 4 OF 5

STEP 5 OF 5

STEP 3 OF 5
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STEP 2 OF 3

Customize your visualization.

Each Flourish template has multiple design elements you can customize to make 
your project unique. From colors and shading to font sizes and curve shapes, 
there are dozens of choices, all created by skilled designers, so no matter what 
you choose, your visualization will look attractive and professional.

Let’s say you like the shape of your graphic but you want 
to change the colors. Click Colours to see a designer 
selection of color palettes. We’ll select Pastel light.

To change the speed that the graphic populates, click 
Animation. Then click Replay to preview the motion.

STEP 1 OF 3
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Altering the shape of the lines is also easy. Simply click on 
Curve under the Line Styles menu item and scroll 
through until you see one you like.

STEP 3 OF 3
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Preview your project on multiple screens.

With more and more readers using mobile devices today, 
it’s very important to preview your data visualization on 
different screen sizes. A font size that looks great on a 
desktop may be unreadable on a mobile phone. A graphic 
that looks beautiful on a phone may look sparse on a 
full-size screen. Flourish makes it easy to see just how 
your visualization will appear.

To preview your project on each screen size, click the 
icons in the upper left corner.

SINGLE STEP
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STEP 2 OF 2

Publish your visualization.

When you’re satisfied with your creation, click Publish to save it and embed it to 
your site. Flourish outputs can be published from your own server and will work 
forever.

If you’re using the free version of this program, your visualization will appear with 
Flourish branding. Publishers using the full, paid version can download the HTML 
file and embed it without Flourish branding. 

Click Export & publish > Publish to share and embed 
and then confirm by selecting Publish.

Click on the URL to view your published animation.

STEP 1 OF 2
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Congratulations!
You completed “Flourish: Data Visualization 
Templates.”

To continue building your digital journalism skills and work toward Google News 
Initiative certification, go to our Training Center website and take another lesson:

6 min estimated time

Google Trends: See what's 
trending across Google Search, 
Google News and YouTube

Find stories and terms people are paying 

attention to.
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Google Trends: 
See what's trending 
across Google Search, 
Google News and 
YouTube
Find stories and terms people are paying attention to.

LESSON 11



How Trends works.

Google Trends allows you to see the topics people are—or 
aren’t—following, almost in real time. Journalists can use this 
information to explore potential story ideas, and can also 
feature Trends data within news stories to illustrate a general 
level of interest in, say, a political candidate, social issue or 
event.

The Google Trends homepage features clustered topics that 
Google detects are related and trending together on either 
Search, Google News, or YouTube. Trending Stories are 
collected based on Google’s Knowledge Graph technology, 
which gathers search information from those three Google 
platforms to detect when stories are trending based on the 
relative spike in volume and the absolute volume of searches.

On the homepage.

Exploring your topics.

Comparing groups of terms.

1

2

3

Explore by language.

Narrowing or expanding your search by geography and time.

4

5

One final Geo Search check: reverse image search.6

Lesson overview
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On the homepage.

The Trends homepage indicates what topics are trending 
right now, which can be helpful when choosing a story to 
write about. To explore how Google data can be used to 
tell stories, click one of the examples under Latest Stories 
and Insights. 

SINGLE STEP
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STEP 2 OF 5

Exploring your topics.

In addition to what you see on the homepage, you can explore and gauge interest 
in virtually any topic, which can be useful for developing story ideas.

Let’s say you’re doing a story on the US presidential election, and want to 
compare the election process with that of India’s General elections happening in 
the same year. Just use the Trends search bar:

Enter the India General Election in the Google Trends 
search bar at the top of the homepage. 

Press Return to see your results.

STEP 1 OF 5
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Your results page will feature data visualizations for 
Interest over time, Interest by subregion and lists of 
Related topics and Related queries. 

You can add topics for simultaneous comparison by 
clicking + Compare and typing in your search term. 

To remove or edit a topic, hover over its box and click the 
three dots that appear. Then click Remove.

STEP 4 OF 5

STEP 5 OF 5

STEP 3 OF 5
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Comparing groups of terms.

You can compare up to five groups of terms at one time 
and up to 25 terms in each group.  Group terms together 
by using a + symbol.

This could be useful to compare election candidates, or to 
look at nominees in an awards show.

SINGLE STEP
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Explore by language.

If you enter a search term using non-Latin characters, 
you’ll see data from all countries or regions that use those 
characters. For example, if you enter 選挙, the Japanese 
characters for election, your results will not include much 
data from the United States.

You can easily compare searches of the same term in 
different languages. Using the election example, just enter 
search term 選挙  in the first search box, then enter 
election in the + Compare  box.

SINGLE STEP
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Narrowing or expanding your search 
by geography and time.

On the results page under the search bar, use the 
Worldwide and Past 12 months dropdowns to refine your 
exploration further by region and/or time period.

SINGLE STEP
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More about Trends.

Information on how to better understand Google Trends 
data and read its charts can be found in our Google 
Trends: Interpreting the Data tutorial, and also in the 
Trends Help Center accessible from the menu in the upper 
left of the homepage.

SINGLE STEP
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Congratulations!
You completed “Google Trends: See what's 
trending across Google Search, Google News 
and YouTube.”

To continue building your digital journalism skills and work toward Google News 
Initiative certification, go to our Training Center website and take another lesson:

4 min estimated time

Google Trends: Understanding 
the data

How to interpret Trends results.
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Google Trends: 
Understanding the 
data
How to interpret Trends results.

LESSON 12



Reading the Interest Over Time graph.

Finding the most searched topic in every region or country.

Rising data.

1

2

3

Reading the Related searches chart.

Data that is excluded.

4

5

Lesson overview
How Trends works.

Google Trends analyzes a sample of Google web searches to 
determine how many searches were done over a certain period 
of time.

For example, if you’re doing a story about the zika virus and 
you want to see if there was a recent uptick in searches on the 
topic, select Past 5 years. Trends analyzes a sample of all 
searches for “zika virus” within those parameters.
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Reading the Interest Over Time graph.

When you search for a term on Trends, you’ll see a graph 
showing the term’s popularity over time in (nearly) real 
time. Hovering your mouse over the graph reveals a 
number, which reflects how many searches have been 
done for the particular term relative to the total number of 
searches done on Google.

Numbers on the graph don't represent absolute search 
volume numbers, because the data is normalized and 
presented on a scale from 0-100, where each point on the 
graph is divided by the highest point, or 100. The numbers 
next to the search terms at the top of the graph are sums, 
or totals.

A line trending downward means that a search term's 
relative popularity is decreasing—not necessarily that the 
total number of searches for that term is decreasing, but 
that its popularity compared to other searches is 
shrinking.

SINGLE STEP
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STEP 2 OF 2

Finding the most searched topic in every region 
or country.

When you search for multiple terms on Trends, you’ll see a comparative map 
showing which term or topic is most searched in each region.

Interest over time comparison: Let’s compare the 
search terms Zika virus and malaria. You’ll find that over 
time, malaria experiences a steady query rate while 
zika was barely searched for until a  huge spike in 
January 2016.

Compared breakdown by subregion: The color intensity 
of each region represents the percentage of searches of 
the leading search term in that region. This example shows 
that Zika virus was a more popular search term in the 
Americas while malaria was relatively more popular in Asia. 

STEP 1 OF 2
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Rising data.

At the bottom of your results page, the Related queries 
chart can show you the Top and Rising terms associated 
with any topic or trending story. 

The Rising tab represents terms that were searched for 
with the term you entered and had the most significant 
growth in volume over the selected time period. You’ll see 
a percentage of the Rising term’s growth compared to the 
previous time period. If you see Breakout instead of a 
percentage, it means that the search term grew by more 
than 5000%.

The percentages are based on the percent increase in 
search interest for the selected time frame. If you’re 
looking at the last 7 days, the benchmark for the rise in 
searches  would be 7 days prior; if it was the last 30 days, 
the benchmark would be for the 30 days prior. The only 
exception is when viewing the full history (2004-Present), 
when the percentages are benchmarked at 2004.

SINGLE STEP
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STEP 2 OF 2

Reading the Related searches chart.

Click the dropdown to see Top terms. 

This table shows terms that are most frequently searched 
with the term you entered, in the same search session, 
with the same chosen category, country or region. If you 
didn’t choose a search term (and just chose a category or 
region), overall searches are displayed.

STEP 1 OF 2
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Data that is excluded.

Trends excludes certain data from your searches:

 - Searches made by very few people: Trends only 
analyzes data for popular terms, so search terms with low 
volume appear as 0 for a given time period.
 
 - Duplicate searches: Trends eliminates repeated 
searches from the same user over a short period of time 
for better overall accuracy.

 - Special characters: Trends filters out queries with 
apostrophes and other special characters.

SINGLE STEP
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Congratulations!
You completed “Google Trends: Understanding 
the data.”

To continue building your digital journalism skills and work toward Google News 
Initiative certification, go to our Training Center website and take another lesson:

20 min estimated time

Google Trends: Improving search 
results

Refine your queries to get more useful data.
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Google Trends: 
Improving search 
results
Refine your queries to get more useful data.

LESSON 13



Refining your search using punctuation.

Interpreting YouTube Geo Search results.

Refining your search by region.

1

2

3

Narrowing or expanding each search topic by geography and time.

Exploring US metropolitan areas.

4

5

Refining your results using categories.

Using rising data.

6

7

Lesson overview
Moving beyond the basics.

Google Trends allows you to easily see the stories and subjects 
that are drawing attention. Exploring topics is a relatively simple 
process, and Trends includes some features and options to 
help refine your results. There are several ways to get the 
precise data you need to help prompt a story idea or support a 
point.
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Refining your search using punctuation.

You can use punctuation to filter your Trends search 
results.

For example, if you’re writing a story about alternative 
energy and search the term wind farm, with no 
punctuation, your results will contain both words in any 
order, along with other words (offshore wind farm, new 
methods to farm wind, wind saves the farm, etc.). No 
misspellings, spelling variations, synonyms, plural or 
singular versions of your terms will be included.

SINGLE STEP
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STEP 2 OF 4

Punctuation guide.

Here’s how various punctuation can affect this search:

“wind farm” – Double quotation marks around your term 
give results that include that exact term, possibly with 
words before and after (offshore wind farm, for example).

wind + solar – Results can include the words wind OR 
solar.

STEP 1 OF 4
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wind - farm – Results will include the word wind, but 
exclude the word farm. This is useful when searching a 
term that’s part of a popular phrase you want to keep from 
dominating your results.

fueling + fuelling + fueleing – Results will include 
alternative spellings (fueling or fuelling) plus common 
misspellings (fueleing).

STEP 4 OF 4

STEP 3 OF 4
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Refining your search by region.

When you search for a term in Google Trends, your results 
will include a map of the world showing areas where your 
term is popular. Darker shades indicate where your term 
has a higher probability of being searched.

Simply hovering over a region will activate a pop-up 
window that reveals its search volume index. On the right 
of the map is a list view icon that displays the ranking of 
top regions or cities based on your term’s popularity.

SINGLE STEP
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STEP 2 OF 4

Narrowing or expanding each search topic by 
geography and time.

On the results page, you can refine your exploration by region and/or time period 
for each individual search topic.

For example, if you compare search interest in Wave 
power and Solar power, you’ll find that Solar power 
typically outpaces the Wave power for worldwide search 
interest. 

If you want to examine local interest in different regions, 
hover over your search term and click the three dots. Then 
select Change filters from the menu.

STEP 1 OF 4
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Specify the region and time period you want to review.

The results may reveal a different relationship between the 
two search terms than what was shown in the worldwide 
comparison. 

STEP 4 OF 4

STEP 3 OF 4
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STEP 2 OF 4

Exploring US metropolitan areas.

Trends even allows you to refine your geographical breakdown to the city level. 
Metros are geographical areas that generally correspond to U.S. metropolitan 
areas. Currently, Google Trends only provides metros for the United States. Let’s 
say you are continuing to research a story about energy and you want to look at 
geothermal energy search trends. You can get information for a specific metro 
area one of two ways:

Click Worldwide at the top of your results page. 

Choose United States.

STEP 1 OF 4
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To examine the data for each metro area, click a 
specific state. 

To view the map by city or metro area, use the Subregion 
menu above the map.

STEP 4 OF 4

STEP 3 OF 4
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STEP 2 OF 2

Refining your results using categories.

If you're using Trends to search for a word with multiple meanings, you can filter 
your results by category to get data for the version you’re looking for.

Search for your term, and on the results page, click All 
categories under the search box to reveal your category 
choices. 

Choose a category most closely related to the meaning 
you prefer.

The results will reflect the number of searches for that 
term in that context.

STEP 1 OF 2
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Using rising data.

Rising shows terms that were searched for with the term 
you entered (or overall, if no search term was entered) 
which had the most significant growth in volume in the 
requested time period. For each rising search term, you’ll 
see a percentage of the term’s growth compared to the 
previous time period. If you see the term Breakout, it 
means that the search term did not exist in the previous 
time period, and we have no baseline.

The percentages are based on the percent increase in 
search interest for the selected time frame. 

Using geothermal energy as an example, if we're looking at 
the last 7 days, the benchmark for the rise in searches for 
the term geothermal energy would be 7 days prior; if it 
was the last 30 days, the benchmark would be for the 30 
days prior. 

The only exception is when viewing the full history 
(2004-Present), when the percentages are benchmarked 
at 2004.

SINGLE STEP
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STEP 2 OF 2

Finding related queries.

When you search for a term, the Related queries chart will appear at the bottom 
of your results page. Related queries can be used to determine the top and 
rising terms associated to any topic or trending story. This can be useful for 
finding unique angles on a story, for example.

On the chart, click the Rising tab and select Top.

Top displays terms that are most frequently searched with 
the term you entered, in the same search session, with the 
same chosen category, country or region.

STEP 1 OF 2
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Congratulations!
You completed “Google Trends: Improving 
search results.”

To continue building your digital journalism skills and work toward Google News 
Initiative certification, go to our Training Center website and take another lesson:

10 min estimated time

Google Fusion Tables: Creating 
intensity maps

Make demographic data easier to understand.
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Google Fusion Tables: 
Creating intensity 
maps
Make demographic data easier to understand.

LESSON 14



Adding Google Fusion Tables to Drive.

Importing your data.

Review your Fusion Table and basic map.

1

2

3

Sourcing boundary data to create customized maps.

Arranging your merge (fusion).

4

5

Aligning your data.

View your shaded map.

6

7

Lesson overview
About Google Fusion Tables

Google Fusion Tables has many helpful features, but the most 
popular by far is its ability to create free choropleth maps 
(intensity maps) with just a few simple steps. This makes it easy 
for journalists to visualize and publish demographic data, such 
as election or population numbers, so that readers can more 
easily understand the story.
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Sharing and embedding your map.
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STEP 2 OF 3

Adding Google Fusion Tables to Drive.

If you’ve never used Google Fusion Tables before, you’ll need to add the app to 
your Google Drive menu:

Click New, then Connect More Apps 

Search for Fusion Tables.

STEP 1 OF 3

142newsinitiative.withgoogle.com



Once you add the app to your Drive, you’ll always see it as 
an option in the menu.

STEP 3 OF 3
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STEP 2 OF 3

Importing your data.

Fusion Tables can import data in formats including .csv, .tsv, .txt and .kml; or 
directly from a Google Sheet. 

Let’s say you’re doing a story on the environmental effects of cattle ranching, and 
want to create a map that represents meat consumption throughout the world. If 
you’d like to use the same sample .csv file of data that we’re using for this 
exercise — global meat consumption numbers — click here to download it.

Click Choose File and select a data file from your 
computer that you want to import, or search public data 
tables. Then click Next.

Preview your Fusion Table data, then click Next.

STEP 1 OF 3
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Here you’ll have the opportunity to add metadata to your 
table, including a table name, data attribution details and a 
description. The Export option, when checked, allows 
other users to export this data as a file. Click Finish.

STEP 3 OF 3
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STEP 2 OF 2

Review your Fusion Table and basic map.

It’s critical to wait until the geocoding from the previous step is complete before 
continuing with the following steps.

Now you’ll see your finished Fusion Table. You can edit the 
information and settings in this window at any time.

Click the Map of Countries tab and you’ll see that the 
map visualization has already been created for you, using 
the location information listed in the column. This will drop 
a red placemark in each of the locations listed.

STEP 1 OF 2
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STEP 2 OF 2

Sourcing boundary data to create 
customized maps.

Let’s say that instead of using placemarks, you’d like to shade whole countries to 
more accurately represent your data. 

To do this, you need boundary data--information that helps place your data within 
accurate borders on a map. Unfortunately, there isn’t one location on the web to 
find all the boundary data you might need, so here are a couple of resources to 
help you get started.

Try searching Google Tables for available boundary 
data sets. 

Also, many boundary datasets have been uploaded by 
users and are free to the public, like this one that we’ll use 
during this exercise, which covers country boundaries 
worldwide.

STEP 1 OF 2
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STEP 2 OF 3

Arranging your merge (fusion).

To create your customized intensity map, you need to merge the table you just 
created in Google Fusion Tables with the boundary data, so that you can shade 
each country based on the meat consumption data. This is where the “fusion” in 
“Fusion Tables” comes from.

First, copy the URL for the boundary data provided (in the 
previous step).

Now go to your meat consumption table and click File, 
then Merge. 

STEP 1 OF 3
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Paste the boundary data URL into the field at the bottom 
of the menu. Click Next.

STEP 3 OF 3
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STEP 2 OF 3

Aligning your data.

In order for Fusion Tables to properly merge two tables, each table needs to 
contain a column of similar, matchable data. 

Now, choose which columns you’d like to merge—the 
information that will be included in each country’s 
description when the map is complete. For this exercise, 
we’ll include all the columns from both tables. Then click 
Merge.

In this case, the column found in both tables is the 
Country Name column. Make sure both are selected in the 
two pulldowns. Click Next.

STEP 1 OF 3
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To return to your Fusion Table, go to the next window and 
click View table. 

STEP 3 OF 3
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STEP 2 OF 2

View your shaded map.

Now click the Map of Geometry tab to see the intensity 
map.

If your map is not already centered in the window, pull it 
down to view it, and use the controls to move in closer to 
reveal your boundary graphics. 

When you click on a country, the corresponding meat 
consumption info should show up in the window.

STEP 1 OF 2
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STEP 2 OF 4

Customizing your shaded map.

Now let’s add a gradient to the map to make it a true intensity map and more 
visually effective for the story. For this exercise, we’ll shade the countries based 
on the 2009 data. 

Click Change feature styles along the left (or, if you don’t 
see that menu, go to Tools, then Change map to get the 
button to appear). 

Under Polygons, select Fill color. Click the Gradient tab 
and then click Show a gradient. In the Column pulldown, 
you can customize the range, or use the suggested range. 
Make sure the 2009 column is selected, as we’ll be 
shading the polygons (country shapes, in this case), based 
on this column of information. Here we can also tweak the 
colors.

STEP 1 OF 4
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In this window we can also add a legend to our map. Just 
select the Automatic legend option in the menu on the 
left, then select a position for your legend. Click Save. 

Now we can more clearly see which countries consumed 
more meat in 2009.

STEP 4 OF 4

STEP 3 OF 4
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STEP 2 OF 4

Sharing and embedding your map.

The map is complete! 

To share and embed this map on your website, first click 
Share.

Change your settings to either Public or Anyone with 
the link.

STEP 1 OF 4
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Now go to Tools, then Publish.

You can copy the URL for the table or copy and paste the 
iframe to embed the interactive map on your website. You 
can also change the height and width of your map directly 
in the iframe.

Use the HTML and JavaScript provided to further 
customize the look and style of your Fusion Tables map. 
You can also get inspired and grab code samples on the 
Google Maps API site.

STEP 4 OF 4

STEP 3 OF 4
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Congratulations!
You completed “Google Fusion Tables: Creating 
intensity maps.”

To continue building your digital journalism skills and work toward Google News 
Initiative certification, go to our Training Center website and take another lesson.
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Google Sheets: 
Scraping data from 
the internet 
Build your own data sets using Google Sheets.

LESSON 15 : Part 01 of 04 in the Visualizing Data module



Lesson overview
Learn to build your own data sets 
using Google Sheets.

There is a massive amount of data available on the internet that 
you can use to research and visualize stories. Finding the data, 
and getting it into a format you can work with is the first step. 

Starting a new spreadsheet.

Finding reliable data.

Importing data to Google Sheets.

1

2

3
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STEP 2 OF 2

Starting a new spreadsheet.

First, you need to create a blank spreadsheet. Go to 
sheets.google.com. Under Start a new spreadsheet, click 
the + icon.

To name your spreadsheet, click the text in the top left 
corner. Let's name this one "Highest Grossing Movies."

STEP 1 OF 2
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STEP 2 OF 2

Finding reliable data.

By sourcing data from government sites, scientific publications, Wikipedia, 
Google Public Data Explorer and more, you can tell data stories on almost any 
topic. In this lesson, we’ll practice with data about movies.

Go to google.com and search highest grossing films. 
One of the first links should be a Wikipedia entry with 
multiple tables. One list, called “the top 50 
highest-grossing films of all time” cites multiple 
references, so we will use that one. Always check to make 
sure you’re scraping data from reliable sources. 

To import this table to Google Sheets, copy the address of 
the Wikipedia page by highlighting the URL, right clicking 
on it, and selecting copy. 

STEP 1 OF 2
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STEP 2 OF 3

Importing data to Google Sheets.

We’ll use  importHTML to import the table from Wikipedia to our spreadsheet. This 
powerful formula is built into Google Sheets to help you import tables or lists 
from web pages. To learn more about how importHTML works and see examples, 
read the Google Sheets documentation pages.

The importHTML tool needs three parameters to work: 
1) a URL
2) the type of data we’re collecting, either a table or list
3) the number representing the position of the table or list 
in the HTML code. 
In this example, the first instance of a table would be 
numbered as one, as the table we want is the first one that 
shows up in the HTML. You can use trial and error to find 
what the position of the table is (1, 2, 3, etc.) or right click 
the webpage, select Inspect > Find to locate the table in 
the code.

Go  to the blank sheet you created and navigate to cell A1. 
Type:

=importHTML("https://en.wikipedia.org/wiki/List_of
_highest-grossing_films", "table", 1)

STEP 1 OF 3
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Notice that the URL and the element type (in our case, 
table) go between quotes — this will make the parameters 
green. The last parameter is a number not within quotes 
and it will be colored blue.

STEP 3 OF 3
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Troubleshooting and error messages.

If you get an ERROR! Message, check to make sure the 
quotes are double quotes as shown in the example. 

If you get a VALUE! error, check to make sure you don’t 
have extra parentheses or quotation marks in the cell.

SINGLE STEP
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Displaying your data.

Once your ImportHTML formula is correct, press enter 
and give Google Sheets a couple of seconds. The table 
should load with all the rows and columns formatted. 

Notice that there are some elements we need to remove 
so that we can visualize this data. We will learn this in the 
next lesson, “Google Sheets: Cleaning data.”

SINGLE STEP
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Congratulations!
You completed “Google Sheets: Scraping data 
from the internet.”

To continue building your digital journalism skills and work toward Google News 
Initiative certification, go to our Training Center website and take another lesson:

Google Sheets: 
Cleaning data

Prepare your data for analysis and 

visualization.

166newsinitiative.withgoogle.com

For more Data Journalism lessons, visit:

newsinitiative.withgoogle.com/training/course/data-journalism

http://g.co/newstraining
https://newsinitiative.withgoogle.com/training/course/data-journalism


Google Sheets: 
Cleaning data

Prepare your data for analysis and visualization. 

LESSON 16 : Part 02 of 04 in the Visualizing Data module



Lesson overview
Learn to clean data in preparation for 
visualization.

In the previous lesson, Google Sheets: Scraping data from the 
internet, we learned how to import a table from the Web using 
importHTML. In this lesson, we'll learn how to clean the data so 
it’s ready for analysis and visualization.

Making data editable. 

Editing the data. 

Batch editing with Find and replace.

1

2

3
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STEP 2 OF 3

Making data editable. 

“Cleaning data” means making it usable to work with: ensuring a table has 
integrity, is free from inconsistencies and is structured in a way that computers 
will understand. That means we will remove duplicate rows, delete undesired 
characters and ensure that columns hold only one type of data, for example 
numbers or text, but not both. First, we need to make the data editable.

This table shows the result of importHTML. In this form, 
any changes to the data source (the Wikipedia page) will 
automatically be reflected here, and are updated at least 
once an hour. However, we can’t edit the values in the cells 
to remove undesired characters. We will use paste special 
in Google Sheets to create a static snapshot of the data. 
With this, we will lose the ability to update the table 
automatically via importHTML, but we will be able to edit 
it. 

Select all of the data by left-clicking in the top left 
rectangle in your sheet. 

Once all cells are highlighted, click Edit > Copy. 

Select Edit > Paste special > Paste values only.  We’re 
now able to edit the table. 

STEP 1 OF 3
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To make editing easier, we’ll freeze the row with the 
names of the columns. 

Hover the mouse cursor to the line just above row 1  over 
the gray bar. You will notice the cursor turns into a glove. 
Drag the bar to the bottom of row 1 and leave it there. 

Now the top row is frozen.

STEP 3 OF 3
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STEP 2 OF 3

Editing the data. 

importHTML will import leftover characters from the Wikipedia table that are 
useful for humans, but not computers. Let’s remove them and make our table 
cleaner!

Since we don’t need column F for this exercise,   right-click 
on the letter F at the top of the column and select Delete.

There is a letter “F” next to number 13 in row A14, and a 
“TS3” next to number 4 in cell B27. We will remove these 
characters so that only the numbers 13 and 4 remain.

STEP 1 OF 3
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Remove the extra letters in cells B40 and B48, so that only 
19 and 8 remain. Do the same in D17 to remove the leading 
“F8”.

STEP 3 OF 3
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STEP 2 OF 5

Batch editing with Find and replace.

Now, take a look at column C. Let’s remove the leading and trailing * characters in 
a batch, rather than row by row, using the Find and replace feature.

Select column C by left-clicking on the letter C at the top 
of the column. Select Edit > Find and replace.

In the first text box type the asterisk symbol: * (that’s the 
character we want to find in column C). Leave the Replace 
with text box empty so that the asterisks get replaced 
with nothing, which means they will be deleted. 

STEP 1 OF 5
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Make sure the Search option says Specific range and the 
range reflects the column you just selected. Leave the 
checkboxes unchecked. 

Select Replace all.

Notice Google Sheets will tell you it Replaced 100 
instances of * with (nothing). That means you 
successfully removed 100 characters in 50 rows with just 
a few clicks! 

Select Done. Our table is now clean and ready for us to 
work with. In the next lesson, we will  produce 
visualizations and get insights from the data. 

STEP 4 OF 5
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Congratulations!
You completed “Google Sheets: Cleaning data.”

To continue building your digital journalism skills and work toward Google News 
Initiative certification, go to our Training Center website and take another lesson:

Google Sheets: 
Visualizing data

Learn to build visualizations that help you 

interpret the data and tell data-driven stories.
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Google Sheets: 
Visualizing data

Learn to build visualizations that help you interpret the 
data and tell data-driven stories.

LESSON 17 : Part 03 of 04 in the Visualizing Data module



Lesson overview
Learn to build a data visualization in 
Google Sheets.

In the previous lesson, Google Sheets: Cleaning data, we 
learned how to clean the table we imported from Wikipedia 
using importHTML. Now, we will use Google Sheets to produce 
visualizations that show readers what the data means.

Creating  a horizontal bar chart.

Adding a title to your chart. 

Resizing a chart.

1
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3
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Improving legibility.
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Publishing your interactive data visualization.6
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STEP 2 OF 2

Creating a horizontal bar chart.

Bar charts are very useful for numerical comparisons. Our first visualization will be 
a bar chart showing which movies made more money and how far the highest 
grossing movies are from the lowest ones.

Select C1, hold shift and select D51, highlighting the two 
columns we will use for the chart.

Click  Insert  > Chart.

In the Chart editor, select Chart type > Bar chart.

STEP 1 OF 2
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STEP 2 OF 2

Adding a title to your chart. 

Now that you’ve made a basic chart, let’s enhance it and make it more readable. 

First, let’s change the title. In the Chart editor, select 
Customize > Chart & axis titles. Change the title to 
“Highest-grossing Movies in the World."

Set Title font to Arial and Font size to 24. Make it bold.

STEP 1 OF 2
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STEP 2 OF 3

Resizing a chart.

To make the chart legible, we need to resize it.

Click on the chart. Drag the bounding boxes, especially 
horizontally.

Click anywhere on top of the movie titles and hover the 
mouse around the vertical edges until bounding boxes 
fade in. Drag the box until there’s enough space for the 
longest title to be read in full.
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Notice that there are 50 bars in the chart, but not 50 film 
titles. That’s because Google Sheets automatically 
distributes the names in the list, omitting some of them, 
to improve legibility. Hover the cursor on top of any bar 
and a tooltip box will appear showing the name and value 
of that bar.
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STEP 2 OF 3

Creating highlights.

Let’s make highlights in the chart to draw attention to specific elements for our 
users.

Change the color of all the bars to gray. In the Chart 
editor, select Customize > Series and select a dark gray 
shade for Worldwide Gross.

Let’s highlight the movie Jurassic Park, the oldest movie in 
the list (1993).

Go to Format data point and click Add.

Select Worldwide gross: Jurassic Park and click OK. 
Choose the color red.
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Let’s do the same thing to highlight all five Harry Potter 
movies in blue.
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STEP 2 OF 2

Improving legibility.

We can further improve the design of our chart by adding gridlines.

In the Chart editor, select Customize > Gridlines. 

In the Horizontal axis, increase the Major gridline count  
to 6 and Minor gridline count to 1. 

Go back to Customize > Horizontal axis. 

In Scale factor, select 1,000,000,000. 

In Number format, select Custom. For Prefix, type $. For 
Suffix, type “ bn” without quotes, and including the 
leading space.

STEP 1 OF 2

184newsinitiative.withgoogle.com



STEP 2 OF 2

Publishing your interactive data visualization.

When you are satisfied with the accuracy, legibility and design of your chart, it’s 
time to publish it.

Hover your mouse in the top left corner of the chart and 
click on the three-dotted icon. 

Select Publish chart > Publish.

You should now have an embed code that you can use on 
your publication. Any changes will be automatically 
republished when made.
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Congratulations!
You completed “Google Sheets: Visualizing data.”

To continue building your digital journalism skills and work toward Google News 
Initiative certification, go to our Training Center website and take another lesson:

Data Studio: Make interactive 
data visualizations 

Give life to your datasets by creating powerful 

interactive visualizations with an easy-to-use 

studio.

186newsinitiative.withgoogle.com

newsinitiative.withgoogle.com/training/course/data-journalism

For more Data Journalism lessons, visit:

http://g.co/newstraining
https://newsinitiative.withgoogle.com/training/course/data-journalism


Data Studio: Make 
interactive data 
visualizations 
Give life to your datasets by creating powerful 
interactive visualizations with an easy-to-use studio.

LESSON 18 : Part 04 of 04 in the Visualizing Data module



Lesson overview
Learn to build visualizations that tell 
your story.

Data Studio is a powerful tool to build interactive visualizations 
that update in real time with data from a variety of sources. In 
journalism, Data Studio enables you to tell stories with data and 
gives you freedom in how to present them. These visualizations 
let users interact with stories from different perspectives. 

Connecting Google Sheets with Data Studio.

Editing your data.

Creating a line chart.

1

2

3

newsinitiative.withgoogle.com/training/course/data-journalism
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Adding a table chart.

Making design changes in your visualization.

4

5

Embedding your interactive visualization.6

For more Data Journalism lessons, visit:

https://newsinitiative.withgoogle.com/training/course/data-journalism


STEP 2 OF 5

Connecting Google Sheets with Data Studio.

Before you begin, make sure you’ve completed our Training Center lessons, 
Google Sheets: Scraping data from the internet and Google Sheets: Cleaning 
data,  and that you’re logged in with the same account. We’ll be using the data 
sheet we created from the Wikipedia article in those  lessons for this visualization. 

Go to datastudio.google.com and begin a new report by 
clicking the blank square with the + icon. 

In Data Studio, visualizations are called "reports." To 
connect our Google Sheet to this report, select Create a 
New Data Source from the bottom right. 

STEP 1 OF 5
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A menu will slide up showing the services we can pull our 
data from. Scroll to Google Sheets and click SELECT.

In the search box, you’ll see all the Google Sheet files 
associated with your Google Drive account. (If this is your 
first time using Google Data Studio, you may need to grant 
permission to access your Drive account.)

Select the spreadsheet and its associated worksheet 
where the data is stored.

Leave all the Options boxes checked and click Connect.

STEP 4 OF 5
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STEP 2 OF 4

Editing your data.

Let’s rename the visualization. Click on the top left corner 
where it says Untitled report. Let's call it “Top 50 Highest 
Grossing Movies in the World.” 

Under Type, change the data in row 5 from Number to 
Date & Time > Year (YYYY). If it's already set as Year (YYYY), 
leave it.
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Select Add to Report, the blue button on the top right. 
Click again on the same option that will pop up.

Let's make the visualization 630 pixels in width and 800 
pixels in height. Click anywhere and type the numbers in 
the Canvas Size section.
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STEP 2 OF 6

Creating a line chart.

We're going to add an interactive line chart showing the worldwide gross for a 
given year. When you click on any year along the line, a table will appear, listing the 
top films, from highest to lowest grossing.  

First, select the rectangle tool and drag the mouse cursor 
across the top of the canvas. Use the text tool to add a 
title. Use the right pane to format the text.

Go to Add a Chart and click Smoothed line chart. 
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Resize it to fit nicely below the title, but leave space for the 
next chart.

To change the dimension, metric and sort for the line 
chart, double click it.

For Dimension, drag and drop Year to replace Title. Next, 
replace Metric with Worldwide gross.

Under Sort, click Worldwide gross, then click Year. 

Change the sort option to Ascending.

STEP 4 OF 6

STEP 5 OF 6

STEP 3 OF 6

194newsinitiative.withgoogle.com



At the bottom you will see a section called Interactions. 
Select Apply filter. This will make every click on the line 
chart an action to filter the table.
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STEP 2 OF 5

Adding a table chart.

Choose Add a chart > Table chart. Resize it to show the 
first 10 rows in the list.

Let’s set up this table with three metrics in this order: Year, 
Rank and Worldwide gross. Go to Metrics and add these 
fields, either by dragging from Available Fields or clicking 
Add metric. 
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Next, go to Style > Table Colors to change the color of 
the header to dark gray.

Go to Table Footer and uncheck Show pagination.

Now, you can add text citing your data source and offering 
instructions for using the chart. Select Text and add it to 
the bottom of the table.

STEP 4 OF 5
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STEP 2 OF 4

Making design changes in your visualization.

Let’s explore some different types of design elements and text you can use to 
customize your visualization. 

To add directional text, such as “Scroll to see more!”, click 
Text and type your message. 

At any time, you can preview your visualization by clicking 
View. To toggle back and forth between View mode and 
Edit mode, simply click again.
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When you're in View mode, you can click on any point in 
the line and the table below will automatically display the 
top 50 movies from that year.  

STEP 3 OF 4
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View mode also lets you see the complete visualization 
you’ve created, including the title, line chart and table 
chart. 
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STEP 2 OF 2

Embedding your interactive visualization.

You can share your visualization via email or by embedding it on your website. 

Share this visualization the same way you'd share any 
other GSuite document.

To embed this interactive visualization on your website, 
click File > Embed report. Check the Enable embedding 
box and use the code on your page.
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Congratulations!
You completed “Data Studio: Make interactive 
data visualizations.”

To continue building your digital journalism skills and work toward Google News 
Initiative certification, go to our Training Center website and take another lesson:
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newsinitiative.withgoogle.com/training/course/data-journalism

For more Data Journalism lessons, visit:

http://g.co/newstraining
https://newsinitiative.withgoogle.com/training/course/data-journalism

